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Pittsburgh Vision Services
Chris Dornfeld, Student Consultant
Mickey King, Community Partner

Situation Analysis  

Organization
Pittsburgh Vision Services’ (PVS) mission is to “reduce the limitations that may result from loss of
vision.”  To carry out this objective, the organization operates a wide variety of programs, such as
teaching the vision-impaired to perform household tasks; providing equipment and assistance for clients
with low vision; teaching Braille and computer skills using assistive technology; offering job training and
positions to blind individuals; and organizing pre-school vision screenings and awareness campaigns.

The entire organization has an annual budget of roughly $7 million and consists of about 175 employees. 
Income is generated through services fees, often paid by the state, as well as grants, donations, and retail
sales of vision-related products.

Facilities
PVS was formed when two former vision services organizations – the Greater Pittsburgh Guild for the
Blind and the Pittsburgh Blind Association – merged in 1997.  As a result, the organization’s operations
and resources are split between two locations: rehabilitation and access technology training are situated at
311 Station St. in Bridgeville while vocational training and most administrative staff are located at 300
South Craig St. in Oakland.

Program
Ms. King acts as Coordinator of Public Education within PVS’ Community and Support Services
department.  She is responsible for providing speakers, arranging tours of PVS’ facilities, handling media
contact, and producing newsletters, annual reports, and brochures.  Maintaining the organization’s World
Wide Web presence has recently become a responsibility of her program as well.  Community and
Support Services has an annual budget of $410,000 and operates out of PVS’ Oakland location.  In 1999-
2000, PVS’ public education reached 4,518 people through presentations on blindness and agency
services and worked with 31 schools through its Children’s Education Program.

Staff
PVS’ administrative staff is composed of its board of directors, president, vice president of financial and
administrative services, administrative coordinators and supervisors, and finally directors of each program
department who manage the heads of individual program areas.

As Coordinator of Public Education, Ms. King uses a computer to prepare materials for use in
publications and correspondence, in addition to communicating electronically with other staff and outside
organizations.

Carole Nadzam acts as administrative assistant to PVS’ vice president of financial and administrative
services and accompanied Ms. King through the consulting process.

Technical Environment
Administrative staff makes use of nearly 100 computers split between the two locations.  Local area
networks (LANs) at each facility are connected by a high-speed line running between Oakland and
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Bridgeville.  In addition, a frame relay connection to the Internet provides access to e-mail and the Web
for administrative staff.  Computers on the administrative network run different varieties of the Microsoft
Windows operating system with Microsoft Office applications alongside custom-built database software. 
The organization’s web site is hosted off-site by its Internet provider.

Computers are also in use at PVS’ Access Technology Center for training clients to use screen readers
and other software and hardware specially designed for the vision-impaired.  New computers are
normally put to use in the ATC first, freeing up older machines for use in the administrative departments.

Ms. King uses a low-end Pentium workstation running Microsoft Windows 98.  Her computer is set up
for Internet access through PVS’ LAN and has Microsoft FrontPage 98 installed and configured to
maintain the organization’s web site.

Technology Management
Until March 2001, PVS had employed one consultant to perform network and system administration and
user support and another to maintain the organization’s database software.  Since then, PVS has added a
full-time information systems administrator to coordinate these activities as well as to develop and
implement technology plans and budgets and maintain the organization’s telecommunications systems.

Based on recommendations made by a technology consultant in November 2000, Pittsburgh Vision
Services is developing a 3- to 4-year technology plan.  The organization’s technology budget is included
in PVS’ general operating expenses.

Problems Addressed  

Task 1: Train PVS staff to maintain the organization’s existing web site and provide
corresponding documentation.

PVS’ web site (http://www.pghvis.org/) is an important tool for attracting volunteers, donors, and vision-
impaired clients to the organization’s services.  The person originally responsible for updating the site is
no longer involved with the organization, and as of my arrival the site had remained unchanged for the 8
months since his departure. In order for PVS to provide timely and accurate information to potential
customers, the staff needed to become familiar with the process of maintaining the site and ensure that
this knowledge is not limited to a single individual.

Results   To address this issue, Mickey King and Carole Nadzam, an administrative assistant, took
responsibility for maintaining the web site, first becoming familiar with how the site’s pages are
organized and then using Microsoft FrontPage to make changes.  They learned to update pages through
such tasks as editing text, adding images, and creating hyperlinks.  Based on PVS’ requirements, we
drafted and refined a customized set of documentation describing the process (Appendices B & C).  Ms.
King and Ms. Nadzam have subsequently been updating the web site independently.

Sustainability   Since there are now two employees trained to do web site updates, PVS no longer risks
losing the ability to maintain its site when one particular employee is unavailable.  Using the web site
maintenance documentation, Microsoft FrontPage’s help system, and the assistance of Ms. King or Ms.
Nadzam, any employee at PVS with minimal computer skills will be able to learn the necessary steps to
update the web site very quickly.
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Recommendations   Because information from throughout the organization is included on the web site,
PVS should determine a system for regularly collecting updated content from each department for use on
the site.  As Coordinator of Public Education, Ms. King already works with other departments to gather
information for publications and other uses, and is therefore well-positioned to collect updated web site
materials alongside her normal duties.  Department heads should be asked to deliver updated versions of
documents used on the web site to Ms. King (or whoever continues to maintain the web site in the future)
whenever changes are made, and new content should be explicitly requested perhaps once a month in
addition to ensure all changes are identified.

Task 2: Research and document accessibility criteria for PVS’ web site and linked sites.

Since PVS’ prospective clients are vision-impaired, it’s essential that the organization’s web site be
compatible with the specialized computer hardware and software they use to browse the Web.  The
current web site is text-centered so as to be fully accessible to those using “screen reader” software, but
some aspects could be made more convenient for vision-impaired visitors, such as minimizing text to
make it easier to skim information quickly.  PVS sought to identify such practices in order to best
accommodate the vision-impaired audience.  In addition, PVS wants to ensure that related sites to which
PVS links meet similarly acceptable accessibility standards.

Results   Along with Ms. King and Carole Nadzam, I reviewed several collections of guidelines for web
accessibility in order to gather suggestions for maintaining PVS’ web site in the most considerate fashion
possible.  Spero Pipakis of PVS’ Access Technology Center, which is responsible for training clients to
use assistive computer technology, provided references to several web resources offering such guidelines. 
After consulting these resources, we identified those accessibility practices most important and applicable
to PVS’ web site in a document explaining the guidelines and technical instructions to be considered
when updating the site (Appendix D).  Since many accessibility guidelines can’t be verified
automatically, outside sites can’t be checked as thoroughly as PVS’ site; for this reason, PVS is
considering requiring linked sites to carry the “Bobby Approved” designation, a widely-recognized
standard for accessible web sites that can be checked automatically.

Sustainability   Both Ms. King and Ms. Nadzam have shown the ability to take accessibility guidelines
into consideration when updating the PVS web site and have demonstrated they are able to do so
independently.  In addition, the documentation describing the accessibility guidelines, along with the help
of Ms. King and Ms. Nadzam, allows others to rapidly become familiar with accessibility practices.

Recommendations   The Bobby web site, which awards the accessibility designation mentioned above,
should be monitored roughly every 3 months for any changes that may arise in the accessibility standards. 
In addition, as PVS becomes more comfortable maintaining its web site, it should consider implementing
additional web accessibility practices above those required to satisfy the “Bobby Approved” guideline. 
The following relevant web sites will be useful as PVS investigates further accessibility refinements:

• Bobby
http://www.cast.org/bobby/
The Bobby home page contains a tool for checking a web site’s accessibility, as well as technical
information on designing web sites to meet several accessibility levels with technical constraints 
ranging from lenient to strict.

• W3C Web Accessibility Initiative
http://www.w3.org/WAI/
This site contains continually-evolving accessibility specifications for web sites maintained by
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the W3C, a World Wide Web standards body.  Bobby checks for compliance with many of these
specifications, but incorporating more of the W3C’s advice would make PVS’ web site an even
friendlier resource for vision-impaired users.

Task 3: Identify resources for redesigning PVS’ web site and begin preparations for a
redesign.

The Pittsburgh Vision Services web site, as mentioned, builds a first impression of the organization not
only for potential clients, but also for potential benefactors and volunteers.  Since this includes many
sighted visitors, it’s also important that the web site reflect PVS in an aesthetically appealing way.  The
current web site is showing its age, and could be redesigned to be more visually attractive while
maintaining its accessibility to those visitors using assistive technology.  PVS’ current site was designed
as a straightforward, textual resource, and could be given a new look while continuing to meet
accessibility requirements.

Results   Ms. King and Ms. Nadzam first identified possible improvements to the web site, in order to
develop an idea of the potential scope of the site.  A document based on the resulting “wish list,”
including recommendations on the steps PVS might take to implement these improvements, items PVS
will be required to provide, and the names of several local web design firms to approach, is attached as 
Appendix E.  We next focused on establishing the requirements for PVS’ web site redesign and
reorganizing the contents of PVS’ current web site in anticipation of a new layout.  Ms. King’s and Ms.
Nadzam’s input on PVS’ needs has been incorporated into a draft proposal suitable for submission to web
design firms (Appendix F).

Sustainability   Using general guidelines for determining web site redesign requirements (Appendix E),
PVS is equipped to evaluate its needs and secure web design services when the organization is ready to
rework its web site.  Ms. King and Ms. Nadzam, in the course of reorganizing the site’s contents, have
become familiar with what is currently contained on the site and are well-prepared to provide input into
making improvements.

Recommendations   Since technology advances so quickly on the World Wide Web, it’s important to keep
pace with and take advantage of the latest web site capabilities.  With PVS’ web site now over two years
old, PVS should take the opportunity to redesign and reorganize it in order to better serve the
organization’s image as well as the users who visit the site for information.  Since relaunching a large
web site is a lengthy process, PVS should begin immediately by finalizing its requirements for a new site
and approaching web design firms to gauge the costs involved.  In this way, the associated expenses can
be considered for the relevant technology budget and a redesign can be commenced as soon as possible. 
Resources relevant to each step of the redesign process, from determining requirements to choosing and
working with a design firm, are documented in Appendix E.

Further Recommendations  

1. Revise the organization’s Technology Plan to include periodic software and hardware
inventories and upgrades.

In any large organization, long-term planning is a necessity in order to successfully manage the costs and
sustainability of resources.  Technology in particular changes very rapidly, making it important to plan
regular upgrades of hardware and software and evaluations of systems and processes.
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Pittsburgh Vision Services currently upgrades and reevaluates technology on an ad hoc basis, replacing
hardware most commonly when upgrades in one department of the company free up more powerful
computers for use in another.  Some software has been updated only when it became unsupported by the
maker, and databases are often revised in response to pressing needs for new functionality.  PVS would
benefit from more structured and routine upgrades and reviews.

Procedure   The organization should consider updating its technology plan to define periodic hardware
and software assessments and to include upgrades for equipment and software that need to be replaced. 
By ensuring its hardware and software are up-to-date and sufficient for the organization’s administrative
tasks, PVS will be able to operate more smoothly and concentrate more of its resources on serving its
clients.

In evaluating whether hardware upgrades are in order, considerations such as these should be taken into
account:

• Is old hardware preventing the use of up-to-date software?  Would hardware upgrades allow the
organization to make use of better software?

• Is software being used inefficiently due to the constraints of slow or obsolete hardware?  Would
newer hardware bring significant advantages in speed or productivity?

• Does old hardware consume a disproportionate amount of support resources?  Would hardware
upgrades decrease support costs?

• How will hardware upgrades affect PVS’ specialized assistive technology, which often has
stringent requirements?

Similarly, several criteria should be examined when considering software upgrades, such as:

• Are the latest software versions in use?  If not, would newer versions stimulate increased
productivity?  Are out-of-date software versions still supported by the publisher?

• Does current software adequately and gracefully meet the organization’s needs?  Are there
competing software packages that better meet these needs?

• Is there an upgrade path from current and proposed software packages to other systems, should a
switch be necessary?

• How will software upgrades affect PVS’ specialized assistive technology?

Addressing these questions regularly is an important step to make sure technological weaknesses are
identified and opportunities exploited.  PVS may choose to reexamine its hardware and software at the
same time as other scheduled reviews, or on a separate cycle, but assessments should occur no less
frequently than every 3 years.  A common strategy is to replace a portion of the organization’s outdated
technology each year in order to minimize annual costs while ensuring all equipment is replaced within a
well-defined timespan.

Impact   Revising a technology plan is a task that can require the time and input of many different staff
members over a matter of weeks.  Changes to the plan should be spearheaded by a committee composed
of PVS’ technology staff along with the organization’s president or vice president in order to pair a
knowledge of the organization’s needs and resources with budget and planning constraints.

The investment in time and effort is worthwhile because of the long-term benefits in the form of lower
technology maintenance costs, higher productivity and predictability, and a smoother administrative
operation.
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Resources   There are many sources of help, both online and offline, for assessing software and hardware
and identifying upgrade needs.  These articles are a good starting point:

• TechSoup
http://www.techsoup.org/articlepage.cfm?ArticleId=38&topicid=2
This introduction to technology asset management explains motivations for evaluating existing
software and hardware and gives advice on keeping track of inventory.
http://www.techsoup.org/articlepage.cfm?ArticleId=35&topicid=2
This article explains the key characteristics to consider when choosing software, such as
compatibility, stability, scalability, and ease of use.
http://www.techsoup.org/worksheetpage.cfm?worksheetid=14
This hardware assessment worksheet acts as a checklist for determining the adequacy of current
hardware and the feasibility of hardware upgrades.

In addition, many software or hardware shortcomings are difficult to identify without familiarity with the
system in question.  For this reason, soliciting feedback and suggestions from staff members regarding
their experiences using hardware and software can be a valuable way to learn about otherwise subtle
inefficiencies.

Finally, trade magazines often review cutting edge hardware and software, identifying its benefits and
caveats.  Providing technology staff with subscriptions to relevant trade magazines and encouraging a
familiarity with the latest technology will help facilitate periodic reviews of the organization’s operations.

2. Identify and reinforce single points of reliance on technical knowledge.

While learning about Pittsburgh Vision Services’ technical environment, I became aware of multiple
instances where the organization was “left out in the cold” after the departure of an employee who held
exclusive technical skills or knowledge.  By making sure technical tasks can be accomplished by more
than one employee and by documenting important procedures and information, PVS will be better able to
sustain its operations when employees leave or are unavailable.

Procedure   PVS should establish a policy of requiring all technical procedures – such as updating the
web site or entering data into a database – to be fully documented and familiar to at least two employees. 
Though ideally PVS staff will observe this policy as a general rule, it’s especially important to make sure
documentation and “backup” staff members are in place when an employee is preparing to leave the
organization.  If necessary, this requirement can be included in periodic staff evaluations or otherwise
verified on a routine basis.  In some cases, the policy could be reinforced by periodically rotating staff
between jobs to ensure multiple employees are able to accomplish certain tasks.  PVS may want to
provide a template and guidelines (see the resources below) in order to standardize its technical
documentation.  Keeping documents in a single location, such as a shared network folder, can help make
the instructions readily available to every employee.

Impact   As with any new company-wide policy, documenting existing procedures will be time-
consuming and done only with great reluctance and varying levels of success at first.  Though the task
could initially take months and will divert employees from other activities, establishing a level of
redundancy in its technology operations will yield an incredible improvement in the long term as PVS
avoids repeating the inconveniences and obstacles it has confronted in the past.
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Resources   While the ability to communicate complex tasks in writing should be a requirement for any
employee, these guides may be helpful to PVS staff in preparing effective technical documentation.

• Online Technical Writing Textbook
http://www.io.com/~hcexres/tcm1603/acchtml/acctoc.html
This online textbook explains how to write successful technical documents, covering task-
oriented writing, revisions, common grammar and spelling problems, peer reviewing, and other
important topics.

• Writing User-Friendly Documents
http://www.blm.gov/nhp/NPR/pe_toc.html
This site offers 23 suggestions for writing documents that are easy to understand and follow. 
This advice is especially important when documenting complex tasks, since concepts that may be
familiar to the author can be confusing if they aren’t clearly and adequately explained.

• The User Friendly Manuals Website
http://www.prc.dk/user-friendly-manuals/ufm/books.htm
For even more detailed information on technical writing, this site links to several lists of literature
on the subject.

• Microsoft FrontPage 98 Basics, Creating and Editing Web Pages with Microsoft FrontPage 98,
and Maintaining Accessible Web Pages with Microsoft FrontPage 98
In addition to online resources, these documents on using Microsoft FrontPage to maintain PVS’
web site (Appendices B, C, and D, respectively) might be helpful to its staff in general as
examples of simple instructions for using software.  Many elements of these documents are
helpful in other technical contexts, such as dividing tasks into clear steps and using illustrations
wherever possible.

As a final possibility, PVS might pursue a relationship with technical writing students and faculty at
Carnegie Mellon, who could benefit from real-life experience while providing valuable assistance to the
organization.  Contact information and specialty information for CMU English faculty is available at
http://english.cmu.edu/people/faculty.lasso

Finally, CMU’s University Outreach office can suggest other possibilities for collaboration.  For more
information, contact Joe Mertz at 268-2540 or joemertz@andrew.cmu.edu, or visit Outreach’s web site at
http://www.cmu.edu/outreach/

3. Establish, and train staff to make use of, a central network location for storing data.

Under PVS’ current network practices, employees have access to shared folders on others’ computers, but
documents are typically kept on individual workstations rather than on a central server.  A centralized
system would offer three main improvements: first, with important files located on a common server,
employees can be sure they are using the latest version of a document; second, a file server allows PVS to
create a “library” for housing shared documents, such as technical instructions (as suggested above) and
employment policies; and third, backing up all of the organization’s critical data will be impractical until
a central repository is used.  To make backups of the staff’s data at present, individual backups of nearly
100 computers would need to be made.  If PVS employees stored data on a central server, a full backup
could be made simply by making a copy of the server’s data.  Protecting its data and operating efficiently
are important to any organization’s productivity.
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Procedure   Since PVS’ technology staff has already configured the network and established shared
folders on various computers, the staff is well-equipped to create server space for documents and to
prepare administrative staff to make use of the space.  Rather, the real work to be done is the development
of an organization-wide policy for storing documents on the network.  This policy should include
instructions on which network drive letter(s) to be used for storing data and how documents should be
categorized into folders on the server.  In addition, some data naturally should not be available to
everyone on the network; if multiple shared folders are created, this information should be included in the
policy as well.

Once a policy is in place, it should be publicized, perhaps through an email to all staff members.  It may
also be necessary to introduce the new methods of opening and saving files at a company-wide staff
meeting or by simply training department heads, who can in turn train the staff in their respective
departments.  PVS already makes backup copies of data on its servers, and these backups can easily
include shared files once the servers are configured to house them.

Impact   Creating the server infrastructure to accommodate a central data store can be handled very
quickly by PVS’ technical staff.  However, determining the hierarchy of folders will likely involve an
assessment of the different types of data currently located on individual workstations.  Deciding on this
hierarchy should most likely be a task involving the heads of each department.  Once a file server is
prepared to store the staff’s files, PVS technology staff will then need to visit each workstation to
configure network drive letters so staff members can access shared files.  With nearly 100 workstations,
this can be expected to take several days, but each workstation should require only a few minutes to
configure.

After all workstations are set up to make use of the file server, training can be expected to require perhaps
an hour of each department head, then another hour involving the department heads and their
departmental staff.  Perhaps twice a year, department heads should look through the files in relevant areas
of the file server and perform “housecleaning” to keep documents well-organized.  Old habits are difficult
to break, so not all staff can be expected to begin making optimal use of a file server overnight.  However,
once the new system is in place, its benefits will quickly inspire the staff to make use of the centralized
server.

Resources   These sites are helpful refreshers for tasks such as organizing files, configuring a shared
folder, and accessing a shared folder through a network drive.

• Windows File Management: Organizing Your Files & Folders Into a Logical Sequence
http://www.smartcomputing.com/editorial/article.asp?article=articles%2Farchive%2Fl0606%2F1
3l06%2F13l06%2Easp
This article explains how to categorize files logically and reviews common Microsoft Windows
file management tasks such as creating folders and moving files.

• File and Printer Sharing
http://innerspan.com/sharing.htm
This page explains how to enable file and printer sharing, share a folder, and map a network drive
to a shared folder.

• World of Windows Networking
http://www.helmig.com/
This site has detailed information on specific networking tasks using each different variety of
Windows.
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4. Create an Intranet to allow PVS staff to access useful documents and information in one place.

While many organizations have web sites for public, external use, it’s also increasingly common to
maintain an Intranet – a private web site accessible only by internal staff.  An Intranet provides a
convenient way to distribute company-related information and documents.  Enabling workers to find such
materials in a centralized location eliminates time spent hunting down common documents and allows
management to alert staff to new policies efficiently.

Building on the previous recommendation, an Intranet at PVS could contain hyperlinks to documents on
the company’s file servers while providing descriptions for each one, removing the need to rely on
filenames alone to identify documents.  Launching an Intranet can help PVS streamline the flow of
documents and information within the organization.

Procedure   First, PVS should determine what materials should be included in an Intranet.  Examples of
items that are commonly contained in an Intranet include:

• company news
• calendars
• policies
• organizational charts
• document templates
• training documents
• sample expense reports
• printer locations

It makes sense to examine how such information is currently obtained in order to get an idea of how
effective an Intranet will be.  Next, a “pilot” Intranet should be built with as much of the desired content
as possible.  As a result of this consulting partnership, PVS staff now has the necessary resources to create
a web site for internal as well as external use.  The Intranet needn’t have a polished design, since it is
purely functional and will only be seen by internal staff.  Once the pilot is prepared, a trial group of staff
(perhaps department heads) should be selected to scrutinize the Intranet and to report on its usefulness
and areas for improvement.  Finally, enhancements can be made based on trial feedback and the full-scale
Intranet put into use.

Impact   Constructing an Intranet will first require administrative staff to gather relevant documents and
information, often a straightforward process.  While Ms. King and Ms. Nadzam are currently capable of
putting together the requisite web pages for an Intranet, other staff members should probably be trained to
create and maintain the Intranet in order to distribute the workload.  The Intranet pilot will require the
trial group to spend minimal time testing the site and providing comments on the results.  Once the full
Intranet is available, someone will be required to keep the information up-to-date, a task that varies in
commitment based on the contents of the Intranet itself.  (For instance, calendars may change each month,
but company policies may be updated rarely.)  Most importantly, the convenience and efficiency benefits
of an Intranet normally make it a clearly worthwhile investment.
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Resources   The following web sites offer useful advice for putting together an Intranet.

• The Complete Intranet Resource
http://intrack.com/intranet/
This site should be the first stop for learning more about Intranets and how other organizations
are using them.  Its helpful features include online Intranet demonstrations, answers to frequently
asked questions, and a discussion board for getting personalized help.

• The Five-Step Process to Implement [an] Intranet to Manage Your Strategic Information
http://www.competia.com/intrack/02-intranet.html
This article outlines the procedures mentioned above in greater detail and recommends several
books related to Intranets.

• Assessing Intranet Cost-Benefits
http://www.fastrak-consulting.co.uk/tactix/Features/costbens/costbens.htm
Though it’s often easy to see the benefits an Intranet can bring about, this site is designed to help
in performing a representative cost-benefit analysis of launching an Intranet.
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Work Plan: Pittsburgh Vision Services Responsibility Target Feb
Date 26 5 12 19 2 9 16 23 30

Task Name
Perform web site maintenance training CP and Consultant 12 March

Understanding how files are stored on a web site CP and Consultant 12 March
Editing and formatting text on a web page CP and Consultant 12 March
Creating hyperlinked text and images CP and Consultant 12 March
Adding images to a web page CP and Consultant 12 March
Adding miscellaneous files to a web site CP and Consultant 12 March
Creating a new page using the existing format CP and Consultant 12 March
Adding text from other sources to a web page CP and Consultant 12 March
Document maintenance procedures Consultant 19 March

Develop accessibility requirements for web site CP and Consultant 2 April
Identify Bobby-compliant guidelines CP and Consultant 19 March
Read other lists of guidelines CP and Consultant 19 March
Make note of additional desired guidelines CP and Consultant 19 March
Review site maintenance using guidelines CP and Consultant 2 April
Document guidelines and maintenance instructions Consultant 9 April

Identify web site design resources CP and Consultant 16 April
Determine requirements for web site redesign CP and Consultant 9 April
Locate resources for web work for non-profits Consultant 9 April
Discuss redesign process with PVS CP and Consultant 16 April
Document redesign procedure and resources Consultant 16 April

Begin preparations for web site redesign CP and Consultant 30 April
Take inventory of current web site contents CP and Consultant 23 April
Make "wish list" of new web site features CP and Consultant 30 April
Reclassify existing web site contents CP and Consultant 30 April

March April

Appendix A

Actual Work Schedule
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Appendix B-1

Microsoft FrontPage 98 Basics

Chris Dornfeld, Student Consultant
9 April 2001

This document explains the following aspects of Microsoft FrontPage 98:

• Launching FrontPage
• Selecting a “Web” to work with
• Understanding the FrontPage user interface
• Publishing changes

To follow these instructions, you should be comfortable with the following common Microsoft
Windows tasks and other concepts:

• Opening a program from your desktop or Start Menu
• Switching between multiple open programs
• Locating files on your computer using Windows Explorer
• Selecting menu items, text, and other window elements using your mouse
• Web site terms such as “pages” and “hyperlinks”

·
Launching FrontPage

Open the program by either double-clicking the “Microsoft FrontPage” icon on your desktop or
clicking “Microsoft FrontPage” in your Start Menu’s Programs list.  Once the program loads,
you’ll be presented with this window:
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Appendix B-2

Selecting a “Web” to work with

In FrontPage, a “Web” refers to a collection of files (pages, graphics, and other documents) making up a
particular web site.  For example, all of the files available on Pittsburgh Vision Services’ web site make
up a “Web” in FrontPage.

Look at the list of available FrontPage Webs (#1 in the window shown above).  To edit the Pittsburgh
Vision Services web site, select the Web named demo_website (local).  If you don’t see a Web with this
name, please ask PVS technology staff to create it for you.  This is a local (in-house) development copy
of PVS’ web site, allowing changes to be fully tested before being published to the world-accessible web
server.
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Appendix B-3

Understanding the FrontPage user interface

The FrontPage Explorer screen

After you select a Web to open, FrontPage will display this screen:

This screen is the FrontPage Explorer window.  The FrontPage Explorer displays all of the files and
folders making up the Web you are working with and allows you to manage these files.  On the left of the
screen (#5) you can select several different FrontPage functions; most of the time you will simply use the
Folders function as described here.

In the “All Folders” area (#1), FrontPage lists all of the folders in the web site.  The folder listed at the top
(labeled “http://king-mickey/testsite” here) is called the “root directory” of the web site.  Underneath the
root directory are several sub-folders used to organize common files.  (Disregard the “_private” folder –
this is a special folder used by FrontPage.)  The “images” folder contains the graphics used on the web
site.  The “newsletters” folder holds the files for PVS’ monthly newsletters.

When you select a folder in the “All Folders” area, the files and folders located in that folder are
displayed in the “Contents” area (#2).  Web pages have names ending in “.html”.  For each of the web
pages in a folder, you will also see the web page’s description in the “Title” column.
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Moving, Renaming, Deleting, and Adding files in FrontPage Explorer

Manipulating files in a FrontPage Web is similar to managing files using Windows Explorer.  For
example, to move a file to another folder, simply drag the filename to its new destination.  To rename a
file, select the filename and press the F2 key, then type in the file’s new name.  When you move or
rename a file, FrontPage will automatically update any links to the file to point to its new location.

To remove files from the Web, select one or more filenames and press the Del key.  FrontPage will ask
you to confirm the deletion and the files will be removed.

You can also add any file from your hard drive to the web site.  To add files to the Web, first select the
folder under “All Folders” where you would like the new files to appear.  Now choose “Import…” from
the File menu.  FrontPage will bring up this window:

Click the “Add File…” button.  An “open file” window will open.  Locate the file on your hard drive that
you want to add to the web site and click the Open button.  The file will appear in the import list (#1). 
Once you’ve used “Add File…” for all of the files you want to import into the web site, click OK.  The
files will appear in the “Contents” list for the current folder.

Other FrontPage Explorer functions

The steps above refer to the “Folders” function of FrontPage Explorer.  From time to time, you will also
want to use some of the other functions to manage the web site’s files and hyperlinks.  The “All Files”
function can help identify “orphan” files in the web site – that is, files which are not referenced in the site
and are probably obsolete or just taking up space.  To use the “All Files” function, click the “All Files”
icon located on the left-hand side of the FrontPage Explorer window.  The screen will change to look like
this:
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The “All Files” list shows all files in the Web, regardless of which folders they are contained in.  Look in
the “Orphan” column for files that are orphaned, identified by a “Yes” entry in that column (#1).  If you
can identify the file and know it’s safe to remove it, select the filename and press the Del key.  Removing
orphaned files will help keep the web site uncluttered and will make it easier to find files you’re looking
for.

Another helpful feature is the “Hyperlink Status” function.  To access it, click the “Hyperlink Status” icon
on the left.  The screen will now look like this:
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Similar to the “All Files” function, “Hyperlink Status” shows the hyperlinks from every page in the Web. 
If a hyperlink’s status is “Broken” (#1), you should correct the link, or visitors to the web site will be
unable to use it.  Double-click a hyperlink to edit its address.  Make sure all links to other web sites begin
with “http://”.  Email links should begin with “mailto:”.

When a link’s status is “Unknown”, FrontPage is indicating that the link looks valid, but it doesn’t know
if the page or site it references is still available.  You can ask FrontPage to check all “Unknown” links by
choosing “Verify Hyperlinks…” from the Tools menu.  FrontPage will then attempt to go to each
“Unknown” link and will keep track of any links that fail.  Be forewarned: This can take several minutes. 
Once the verification is done, the status of any broken links will be marked “Broken” in the list so you
can make changes to their addresses as needed.

Publishing changes

After making changes to the local development copy of the PVS web site and verifying that they are
ready to go “live,” you can update the live PVS web server (that is, what you see at
http://www.pghvis.org/) by clicking the “Publish” button on the FrontPage Explorer’s toolbar (as shown
in the screenshot above).

You will be asked for the username and password needed to make changes to the live web site.  You
might want to record them here for convenience:

USERNAME:                                     _
PASSWORD:                                     _
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(Note: the username and password may be case-sensitive; be careful when entering them and writing
them down.  If you don’t have the username and password, or to have the password changed, contact
StarGate at 412-316-7827 or 877-570-7827.)

Next, FrontPage will compare all of the files in the local web site with those files located on the live web
server.  FrontPage will then upload any new or changed files and instruct the live web server to remove
any files you have deleted.  This may take anywhere from a few seconds to several minutes, depending on
the number of updated files to be sent and how many others are using PVS’ Internet connection at the
same time.  Once the publish operation is done, your changes will be available at http://www.pghvis.org/. 

See also:

Creating and maintaining web pages with Microsoft FrontPage 98
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Creating and editing web pages with
Microsoft FrontPage 98

Chris Dornfeld, Student Consultant
9 April 2001

This document walks through the following tasks using Microsoft FrontPage 98:

• Creating a new web page using the format of an existing page
• Opening an existing web page for editing
• FrontPage Editor basics
• Editing and formatting text on a web page
• Adding images to a web page
• Adding text to a page from other sources (e.g. Microsoft Word documents)
• Adding miscellaneous files (e.g. Adobe Acrobat documents) to a web site
• Creating and editing hyperlinked text and images
• Editing a page’s search engine keywords

As a prerequisite, you should be comfortable with the tasks described in Microsoft FrontPage 98 
Basics, as well as with using a Windows word processor such as Microsoft Word.

Creating a new web page using the format of an existing page

When you add a page to a web site, very rarely should you start from scratch with a blank page.  It’s
important that all of the web pages belonging to a web site have the same appearance and navigation
functions.  For this reason, you should always begin with an existing web page that has the layout and
design you want to mimic.  Then save a copy of this “template” page and replace titles, body text, etc.
with your new content to create the new page.

The first step is to open FrontPage and bring up your Web.  You should see the web site’s files displayed
in FrontPage Explorer, like this:
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Now you should select an existing web page as a template for your new page.  If you aren’t sure which
page to use, you can either open and look at some existing pages or browse the PVS web site to find a
good candidate.  To open and view a page in FrontPage, double-click its filename in the “Contents” list.  
To locate a template by browsing the PVS web site, open http://www.pghvis.org/ in your web browser
and navigate to the page you want to mimic.  Now look at the page’s address in your web browser.  For
example, if the address is “http://www.pghvis.org/goodtemplate.html”, you would use
“goodtemplate.html” as a starting point for your new page.

Next, open the page you selected as a template by double-clicking its filename in the FrontPage Explorer. 
A new window – the FrontPage Editor – will open:
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IMPORTANT: Before editing the page, save a copy into a new file.  Select “Save As…” from the File
menu, and you will see the following window:

In the “URL” text box (#1), enter an appropriate name for your new page.  Filenames should be one word
(no spaces!), are normally all-lowercase, and should be short but descriptive.  If there will be several
pages like your new page (e.g. monthly newsletters), be sure to choose a unique filename accordingly
(such as “newsletter12.html” instead of just “newsletter.html”).  Make sure you save your file in an
appropriate folder.  If your new page belongs in a folder with other similar pages (like the “newsletters”
folder in the window above), be sure to save your page in that folder.  If you want to make a new folder to 
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contain your page and future similar pages, use the “Create New Folder” button (#3).  As with filenames,
make sure your folders have lowercase and short but descriptive names.

IMPORTANT: Your filenames should almost always end in “.html”.  The exception is when you are
creating a “home page,” in which case your file should be named “index.asp”.  For example, when a
visitor goes to the web address “http://www.pghvis.org/”, she hasn’t specified what filename she wants;
the web server then tries to serve the default home page (index.asp) from the root folder, as if she had
requested “http://www.pghvis.org/index.asp”.  This applies to folders underneath the root folder as well;
if an index.asp file is present in the “newsletters” folder, the address “http://www.pghvis.org/newsletters/”
will bring up “http://www.pghvis.org/newsletters/index.asp”.

Before saving your page, make sure you edit the “Title” field (#2) to give a new title to your page.  This
title will be displayed next to the filename in file listings (such as in the window above) and will also be
the window caption when the page is viewed in a web browser.  The title can be several words long and
should give an idea of what is on the page without having to open it.  Since the title will be displayed to
web site visitors, be sure to capitalize words.

Now that you have made a copy of the template page, you must edit it to reflect the page you are trying to
create.  For example, if you were using the web page shown on Page 3 as a template for a new Summer /
Fall newsletter, you might begin by changing the “Winter / Spring 2001 Newsletter” heading to “Summer
/ Fall 2001 Newsletter”.  See below for details on editing a web page.  When you have finished editing
the page, remember to choose “Save” from the File menu.

Opening an existing web page for editing

To open an existing page, first launch FrontPage and open your Web.  Using the FrontPage Explorer,
locate the file you want to edit.  Double-click its filename to open the file in the FrontPage Editor.

IMPORTANT:  When making changes to an existing page in PVS’ web site, be sure to check for search
engine keywords that may be associated with that page and update them accordingly.  See “Editing a
page’s search engine keywords” below.

FrontPage Editor basics

The screen shown at the top of Page 3 is the FrontPage Editor window.  The first toolbar contains buttons
to save, print, copy, paste, etc.  The toolbar below should be familiar from Microsoft Word: it allows you
to change fonts and font sizes, and to make text bold, italic, etc.  All of these toolbar buttons are
shortcuts for menu items and can also be accessed through the menu system.

Below the toolbars is the editing area where the web page you’re editing is displayed.  While you’re
editing a page, it will look more or less the way it will appear when posted to the web site.  However, you
can use the “Preview” tab at the bottom of the screen to test your page in a web browser.  When you’re
done previewing, don’t forget to click the “Normal” tab to return to editing mode.

Editing and formatting text on a web page

The FrontPage Editor works very much like Microsoft Word and other Windows text editors.  To insert
text, just click to position the cursor and begin typing.  To change existing text, select it using your 
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mouse.  You can now press Del to erase it, or type other text to replace it; to change the text’s typeface,
font size, justification, or text decoration (bold, italic, etc.), use the formatting toolbar buttons, which are
the same as those in Microsoft Word and other applications.  There’s one key difference in editing text
using FrontPage: often, hitting ENTER will advance 2 lines and begin a new paragraph.  To force
FrontPage to do a “normal” ENTER, use Shift+ENTER.

You can designate “bookmarks” within a web page to allow hyperlinks to jump to a certain spot within
the page.  This is useful for creating tables of contents, for instance.  To define a bookmark, select text in
the area you want to mark (that is, the spot you want to be able to jump to) and choose “Bookmark…”
from the Edit menu.  You’ll see this box:

Type a name for the bookmark in the “Bookmark Name” box, then click OK.  The text you selected will
now be underlined with a broken line, indicating the text is bookmarked.  You can now create hyperlinks
which skip directly to this point in the page (see “Creating and editing hyperlinked text and images”).

Adding images to a web page

To add a graphic to a web page, you first need to copy it from your hard drive to the web site.  (See the
instructions for adding files in Microsoft FrontPage 98 Basics.)  Once your file is part of the Web, and
you have opened a web page in the FrontPage Editor, select the Insert menu and choose “Image…” 
Select the graphic you want to add to the page and it will appear in the editor.  Just like text elements, you
can change the graphic’s justification using the toolbar buttons.

IMPORTANT: See Maintaining Accessible Web Pages with Microsoft FrontPage 98 for information on
specifying alternate text equivalents for images.

Adding text to a page from other sources

Often you will want to incorporate content from an email, Microsoft Word file, or other document into a
web page.  To transfer this content from its original location to a web page, the easiest method is to copy
it to the clipboard and then paste it into a web page.

For example, if you want to copy text from a Microsoft Word document into a web page, first open the
document in Word.  Select the text you want to copy, then pick “Copy” from the Edit menu.  Now run
FrontPage and open the destination web page in the FrontPage Editor (see “Opening an existing web page
for editing” above).  Click within the web page to position the cursor where you’d like the text from the 
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Word document to appear.  Now choose “Paste Special…” from the Edit menu.  The following window
will appear:

As in the window shown here, select “One formatted paragraph”.  This setting will make sure the
imported text looks as similar to the original document’s layout as possible.  (If you want to include the
copied text without formatting (fonts, italics, etc.), select “Normal paragraphs” here instead.)  Click OK
and the text will be pasted into the web page.

IMPORTANT: Text pasted into a web page from other sources won’t look exactly like the original.  For
example, tabs may not translate correctly into FrontPage.  Be sure to look over the web page after pasting
text to make sure the presentation is acceptable.  If possible, make use of tables instead of tabs in
Microsoft Word documents, since tables transfer more cleanly onto web pages.Adding miscellaneous files
to a web site

From time to time, you will also want to add other types of files to the web site, such as Adobe Acrobat
(PDF) documents.  To include miscellaneous (non-HTML, non-graphic) files, first add them to the web
site using the instructions in Microsoft FrontPage 98 Basics.  Once they’re added to the Web, you can
insert hyperlinks to your PDFs or other files as outlined below.

Creating and editing hyperlinked text and images

Hyperlinks are an important part of a web site.  They provide a means for visitors to move from one page
to another, to send email, and to download files posted on the site.

Links can be either text or graphics.  Hyperlinked text appears underlined on a web page and can be
clicked to open a specified address or file.  Hyperlinked graphics usually appear with a solid outline and
can also be clicked to follow a link.

To link text or images on a web page to another page, an email address, or a file, select the text (type it in
first if needed) or click once on the image in the FrontPage Editor.  Now choose “Hyperlink…” from
the Insert menu, and you’ll be presented with the following window:
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If you want to link to another page or file within the same web site, use the file list to locate the
destination file and click its filename.  FrontPage will put the file’s address in the URL field (#1).  To
link to a different web site, type in the address in the URL field directly (remember to start it with
“http://”).  If the destination page has “bookmarks” – designated sections on the page which can be
jumped to directly – you can select a particular bookmark (#3).  (See “Editing and formatting text on a
web page” for instructions on defining bookmarks within a page.)

To make the link send email instead, click the envelope button (#2).  A box will appear asking for the
email address to link to.  After you enter the address, FrontPage will update the URL field accordingly.

Click OK to create the link, then use the FrontPage Editor’s Preview function to make sure it works
correctly.

To edit an existing hyperlink, e.g. to change its address, right-click anywhere within the hyperlinked
text or on the hyperlinked image and choose “Hyperlink Properties” (for linked text) or “Image
Properties” (for linked images).  For images, next click the “Browse…” button next to the Default
Hyperlink Location.  FrontPage will display the following window:
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Make changes to the URL or other fields by following the same steps above for creating a link.  Click OK
to close any open windows after making your changes.

IMPORTANT: Don’t forget that hyperlink captions are completely separate from link addresses. 
For example, you might type the text “clinton@whitehouse.gov” onto a web page, then select the text and
create an email link to “clinton@whitehouse.gov”.  If you later want to update the link to point to
“bush@whitehouse.gov”, just editing the caption text isn’t enough; you must also edit the hyperlink
address itself to reflect the new email address.  If you’re not careful, you can end up with a link that reads
“bush@whitehouse.gov” but still sends email to “clinton@whitehouse.gov”!

Editing a page’s search engine keywords

Many of the pages on PVS’ web site contain lists of words intended to be used by search engines when
indexing the pages.  For instance, a particular page might specify keywords “blindness” and
“rehabilitation” to allow users to find the page when using a search engine to search for these words. 
Note that search engines typically index all of the words in the text of a page, but any keywords
associated with the page will be considered as well, regardless of whether these keywords appear in the
page’s text.

In practice, modern Internet search engines seem equally effective, and sometimes more accurate, when
relying on a page’s text alone.  For this reason, it’s not normally important to explicitly specify keywords
for new pages.  However, many existing pages on PVS’ web site contain search keywords, and these lists
of keywords must be maintained along with the page text.

For example, one page on PVS’ site may mention an annual award given to John Smith and specify his
name as a search keyword.  If the page is updated the following year to reflect a new award recipient, that
page’s list of keywords should be changed to make sure John Smith’s name is no longer associated with 
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the page.  To edit a page’s keywords list, open the page in the FrontPage Editor, right-click in the page
body, and choose “Page Properties”.  Choose the “Custom” tab at the top of the Page Properties
window, and you should see the following items:

Look in the “User Variables” list for a “keywords” entry (as highlighted here).  If a keywords list is
present, highlight its list entry and click the Modify button to examine the full list and make changes. 
(Keywords should be separated by commas.)  Check to make sure all of the keywords specified still apply
to the page in its current form.  You should delete keywords that no longer apply, but it’s not critical to
add new ones, as search engines no longer need the aid of keyword lists in most cases and will do an
effective job using the page’s body text alone.

See also:

Microsoft FrontPage 98 Basics
Maintaining Accessible Web Pages with Microsoft FrontPage 98
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Maintaining accessible web pages with
Microsoft FrontPage 98

Chris Dornfeld, Student Consultant
2 April 2001

This document explains how to edit  web pages in Microsoft FrontPage 98 while ensuring that they
remain accessible and usable to visitors using screen readers and other assistive technology.

As a prerequisite to the tasks described below, you should be comfortable with the material described in
Microsoft FrontPage 98 Basics and Creating and Editing Web Pages with Microsoft FrontPage 98.

Introduction

Any time you create a new web page or make significant changes to an existing page, it’s good practice to
run it through Bobby (http://www.cast.org/bobby/) as part of the process.  Bobby asks for the URL (web
address) for a page, then checks that page for accessibility problems.  After you have published an
updated page to the live web site, you can find its URL by navigating to the page in your web browser,
highlighting the address shown, and choosing Copy from the Edit menu to save it to the Windows
“clipboard.”  Then go to the Bobby home page, highlight the text in the URL box, and choose Paste from
the Edit menu to replace it with the updated page’s address.  Click the Submit button and Bobby will give
a report on potential accessibility issues beneath a copy of the page itself.

Bobby reports potential problems according to 3 priority levels.  Only “priority 1” problems must be
resolved in order to qualify for “Bobby Approved” status, and you should pay attention mainly to these
issues.  However, many accessibility problems don’t apply to PVS’ web site or otherwise can’t be
checked automatically.  With this in mind, the following tasks are the most important to consider when
making updates to PVS’ site:

• Specify alternative (“ALT”) text for images
• Make sure link captions are concise but descriptive when read out of context
• Avoid using color alone to convey information

These items are described in detail below.  When you’re done making any significant changes using
FrontPage, remember to use Bobby to check the updated pages.  If possible, also ask a user of JAWS or
other screen reader software to visit the pages and report any problems.
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Specify alternative (“ALT”) text for images

While a screen reader can read text on a web page, it can’t “read” a photograph.  In order to give a vision-
impaired web site visitor a substitute for the information conveyed by an image, you must specify a text
description for the image which can be read by a screen reader.  For example, the PVS home page is
headed by an image of the PVS “eyeball” logo.  Embedded in the page is the following description text
for this image:

PVS Logo which is two arms cupped together and a sun-like circle in the middle of them to form
the symbol of an eye.  The agency's logo appears in the color black on this web site but it is
actually a royal blue.

When a web site visitor uses a screen reader to load the PVS home page, she will hear this description
where the logo graphic appears.  A traditional web browser will also display this caption when the mouse
cursor is held over the image for a second or two.

When adding an image to a web page using FrontPage (see Creating and Editing Web Pages with
Microsoft FrontPage 98), you should almost always specify a text description.  After you have added an
image to a web page in the FrontPage Editor, right-click the image and choose “Image Properties…”  You
will see the following window:

In the Text box (shown as #1 above), enter a description for the image, then click OK.

Note that there are some cases where it’s not appropriate to provide a text description for an image.  For
example, if an image is being used for spacing or otherwise doesn’t convey any useful information,
specifying a description may be unnecessary.  On the other hand, for a graphic such as a photograph, you
will almost always want to give a description.  You will have to decide for each image whether a
description may be safely omitted.
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• For more information on Rehabilitation Services select this link.
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• For more information on Community Education Services select this link.
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Make sure link captions are concise but descriptive

Web site visitors using screen readers often use a “links list” feature to navigate a web page.  This feature
presents all of the hyperlinks on the current page and allows the user to quickly choose a destination.  One
screen reader’s links list window looks like this:

Links are listed in the links list window according to the hyperlinks’ captions (the underlined text) on the
web page.  In this screen shot, one of the links reads “plain text”.  This link may have appeared in the web
page like this:

While the link’s purpose is clear to a visitor using a visual web browser, when the hyperlink caption
(underlined text) is read out of context, it’s not clear what the text “plain text” references.  A better way to
present this hyperlink might look like this:

Now when we view the underlined text out of context, it will read, “download a plain text version of this
page” rather than simply “plain text”.  When selecting text for a link caption, remember to read the
text by itself and make sure it specifically describes where the link points.  This way, screen readers
will be able to present meaningful link captions to vision-impaired web site users. When you are choosing
link captions, don’t forget that a screen reader presenting a links list will need to read each link caption
out loud.  While your captions should be descriptive, they should also not be too descriptive.  Consider
the following list of links on a web site:
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Appendix D-4
When this segment of the web site is processed by the screen reader to present the links list, all of the text
above will be present in the list.  The user will need to listen to 29 words (the first 3 link captions) before
hearing the fourth link; this will take several seconds and will likely be irritating if the user is looking for
the fourth link.  Most of the text the user hears (“For more information on” and “select this link”) will be
redundant.  By specifying more concise link captions, the vision-impaired user will be able to navigate
through the links much more quickly:

Using this revised section, the screen reader user would only hear 8 words before coming to the desired
fourth link, allowing her to move to the next page much more quickly.  When defining link captions,
leave out redundant and unnecessary words and remember that screen reader users must listen to
each caption in order to find links of interest.

Avoid using color alone to convey information

It’s often tempting to distinguish information using colors, e.g. “services shown in red are not covered by
the basic plan.”  Color is an effective way of visually conveying information, but to the vision-impaired
and software such as screen readers, it is awkward and ineffective.  When organizing and presenting
information on web pages, look for other ways to convey the information, such as separate lists or other
methods that may be appropriate for the material at hand.

See also:

Microsoft FrontPage 98 Basics
Creating and Editing Web Pages with Microsoft FrontPage 98



Pittsburgh Vision Services Page 32 of 37
Chris Dornfeld, Student Consultant 14 May 2001

- Page 32 -

Appendix E-1

The Web Site Redesign Process

Chris Dornfeld, Student Consultant
30 April 2001

This document explains the process of soliciting web design work and working with a design
firm to complete a web site redesign project.

Introduction

Even the slickest web sites require a facelift every 2-3 years, if not more frequently.  A fresh
look lets visitors know that an organization takes the Web seriously and gives the organization a
chance to reorganize content and incorporate feedback from the site’s visitors.  Operating a web
site is an ongoing process in which the site’s content and presentation are continually refined.

Most organizations’ web sites follow a very similar evolution.  First, content from existing
sources (such as brochures) is adapted directly to the Web.  In the first reincarnation, content is
prepared especially for the Web, taking into account the medium’s strengths and constraints. 
Subsequently, sites may become even more complex as needed, offering content customized to a
visitor’s preferences and becoming highly interactive.

Pittsburgh Vision Services’ current web site consists mainly of long pages of text in black and
white and would benefit from a redesign of both its content and its look and feel.  For instance,
since most web visitors have short attention spans and slow Internet connections, a site’s home
page should be concise and to-the-point.  A good web design firm is aware of such “tricks of the
trade” and will be able to produce a site that’s appealing and usable to visitors while representing
the organization effectively.

An organization should know what to expect when seeking web site development work and what
it will be required to provide.  The following aspects of the process are explained in more detail
below:

• Why to hire professionals for web design work
• Shopping for and selecting a web design firm

o Identifying requirements
o Locating potential firms
o Reasonable expectations for price and timeframe

• Responsibilities during the design process
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Why to hire professionals for web design work

Many organizations, even small ones, use in-house staff for designing and maintaining their web
sites.  PVS may or may not currently have staff members with design or technical skills
applicable to a web site redesign; regardless, there are several good reasons to seek outside
expertise for such a project:

• PVS’ web site is expected to meet special accessibility requirements for the vision-
impaired.  Only web site developers with strong technical skills will be comfortable
designing a site to satisfy these constraints.

• Web sites have specific design requirements requiring specific artistic training.
• Even when existing employees have experience suitable to developing web sites,

diverting their time to a web site redesign project may be impossible or undesirable.

In short, experienced web development firms can streamline what is often a chaotic process
under other circumstances.  It’s also worth noting that relevant internal resources need not go
entirely unused; web design firms are happy to work with existing designs or design ideas, for
instance, when producing a web site.  In addition, hiring an outside firm for a web site redesign
allows internal staff to continue to maintain the site independently.

Shopping for and selecting a web design firm

Identifying requirements

The first item of business in soliciting redesign work is to establish the specifications of the
finished product.  The requirements will help firms determine whether they are equipped to
perform the necessary work in the specified timeframe, and how much it will cost.  The
following items should be included in a requirements list, along with any other information that
may affect the type or amount of services a firm would be expected to provide.

• Roughly how many pages or sections will make up the web site?
• What sort of content will be used on the site?  Aside from text, will there be photographs,

animations, etc.?
• Who will provide the content for the site’s pages?  (Normally the organization, but firms

are often asked to produce multimedia.)
• How will the content be delivered?  Will the firm be required to scan and retouch logos,

photographs, and documents, or will the organization provide these items electronically?
• In addition to pages, will the firm need to write computer programs to support the web

site?  (Such programs are most commonly required to process data entered in fill-in
forms on a web site.)

• What, if any, are the technical constraints on the web site?  Will the site need to be
hosted by a specific web hosting service?  Will the site be maintained later on using
software such as Microsoft FrontPage?  Must the site meet standards such as the “Bobby
Approved” guidelines for accessibility?
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Will the design firm need to register a domain name (e.g. pghvis.org) for the
organization?  Will the firm need to arrange hosting for the web site?

• Will the firm need to publicize the site by submitting its address to search engines and
web site directories?

• What is the target date for completing and launching the new web site?

In addition to answering these questions in a requirements list, it’s also a good idea to ask
up-front whether a firm has a discount for non-profit organizations.

Locating potential firms

There is an abundance of companies prepared to perform web design work.  When
choosing a company for the first time, you should keep several prospective firms in mind
in order to accumulate multiple estimates for a project.  You will probably want to use
several of the following strategies to identify possible candidates:

• Ask contacts at similar organizations for the names of companies they have used.  (But
only if you like the web sites they’ve produced!)

• Ask other employees, especially technology staff, for recommendations.
• Check the local yellow pages.
• Consult online directories, such as Yahoo!:

http://dir.yahoo.com/Regional/U_S__States/Pennsylvania/Cities/Pittsburgh/Business_and
_Shopping/Business_to_Business/Communications_and_Networking/Internet_and_Worl
d_Wide_Web/Web_Site_Designers/

Whenever possible, visit a web design firm’s own web site before deciding whether to
consider that firm.  Even a quick look at a firm’s home page is usually sufficient to help
“weed out” many companies.  (If a “web design firm’s” home page looks amateurish or
hasn’t changed in 2 years, it’s probably not worth inquiring.)  In addition, company web
sites will list services offered and will often contain client lists and links to representative
sites.  As a general rule, if you aren’t impressed by a firm’s web site and by the web sites
in its portfolio, chances are you won’t be blown away by any work they perform for you.

Finally, while many web designers are equipped to work long-distance by email and
telephone, hiring a local firm is typically a better idea.  With local help, you can meet
face-to-face to discuss design ideas and clarify revisions, resulting in a closer working
relationship and less room for confusion.

The following local firms, found in the Yahoo! listing above, might be worth checking
out:

• Labwerks Interactive (http://www.labwerks.com/)
• Mica Media (http://www.micamedia.com/)
• Ripple Effects Interactive (http://www.r-effects.com/)
• Spinne Web Site Services (http://www.spinneweb.com/)
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Reasonable expectations for price and timeframe

Price   There are no hard-and-fast rules for estimating how much a web site will cost. 
Indeed, the cost of producing a given set of web pages may vary greatly depending on
what “accessories” are needed.  Since different firms will deliver a wide range of
estimates, it’s common practice to present your requirements to several different
companies and seek multiple quotes for comparison.  Be aware that several pricing
models are in common use:

• Hourly – The firm will estimate the time it will take to produce the site, then make an
estimate according to its hourly rate.  If your requirements do not accurately reflect the
amount of work needed, hourly estimates will be equally inaccurate.  Don’t forget to
budget extra time beyond these estimates for the inevitable revisions and changes to the
specifications.  Hourly fees may be anywhere from $20 to $100/hour, while $40-$50 is
roughly average.

• Project Price – Also known as “lump sum,” some firms will quote a fixed price for a
project and deliver the final product at this price, no matter how much time it takes.  If
the quote is reasonable, this pricing model is attractive, since you needn’t worry about
outspending your budget.

• Per-Page – Some firms make estimates for web site work based on the number of pages
to be produced.  Be skeptical of this model, since once the design for a site is finished
and the first page is created, subsequent pages are simple carbon-copies of the original. 
In addition, a page may contain anything from a few simple paragraphs to dozens of
photos and tables.  This pricing model is not necessarily a sign of an unprofessional
design firm, but in most cases it addresses the requirements less accurately than the
previous models.

Though it’s tempting to set a budget beforehand for a web site redesign, the best course
of action is usually to gather several estimates before settling on a budget, unless you are
already aware of the prices of similar organizations’ web sites.  Also watch out for
extremely low estimates: they may indicate that a firm underestimates or misunderstands
the requirements, and aren’t necessarily the sign of a bargain.

Timeframe   Once again, there’s no easy way to estimate how long you should expect the
web development process to take.  For anything more than a handful of pages, think on
the order of months.  Try to imagine the longest amount of time you would expect the
project to take – then double it.  In most cases, design firms are held up waiting on
information and feedback from their clients, rather than vice-versa.  You should consider
how long it will take you to prepare the content for the web site.  Will you need to gather
documents and other materials from several different people?  How long will it take to
earmark content for individual pages?  How many employees will be submitting
feedback and revisions when the work is completed?
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When designing web sites, “the devil is in the details.”  Like other complicated
undertakings, the final 10% of work often takes as long as the first 90%.  Keep this in 
mind when making budget and timing estimates.  Responsibilities during the design
process

Once you have selected a design firm and work has begun on the project, there will be
many items you’ll need to supply to the designer to facilitate the process.  The firm will
need the following materials to create the web pages themselves:

• A crisp copy of the organization’s logo, if it will be included on the site
• An outline or diagram detailing the hierarchy of pages making up the site
• The text and other content that will fill each specified page

As mentioned earlier, providing electronic source copies of your logo, page text, and
images will be faster and less expensive, though firms can also use paper copies if
nothing else is available.

You can otherwise give a design firm free reign over your site’s look and feel, but in
most cases you will want to direct its development in several ways, such as:

• Specifying common navigation features, such as links that should appear on every page
• Specifying typefaces and font sizes used for text on the site
• Specifying any legal or copyright notices that should appear on each page
• Providing design preferences and ideas, such as possible color schemes or other sites to

use as models

For an excellent list of suggestions to follow when putting together a web site redesign,
see Three Rivers Free-Net’s Website Authoring Tips at
http://trfn.clpgh.org/About/tips.html

Background

The student consultant, Chris Dornfeld, has been creating web sites the old-fashioned
way for about 6 years.  He currently operates a web site development business with a
friend.  (Sorry, but he will not be working out of Pittsburgh after graduation!)
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Sample Web Site Redesign Requirements

Chris Dornfeld, Student Consultant
1 May 2001

This is a sample requirements document for a web site redesign project, prepared for
Pittsburgh Vision Services using the criteria listed in The Web Site Redesign Process. 
The text below is a model “request for quote” suitable for delivery to potential web
design firms when soliciting estimates.  Some firms may request more details, such as an
outline of the pages planned for the site, so it helps to prepare such items in advance of
price shopping.

Request for Quote

Pittsburgh Vision Services, a non-profit blind services organization with locations in
Oakland and Bridgeville, seeks web site design and development services to rework and
redesign its existing web site.  The redesigned site’s requirements are as follows:

• The site will include 50-75 individual pages of text and several photographs.
• Pittsburgh Vision Services will provide electronic copies of all text and photos.
• A form processing script will be needed to handle data entered into a feedback form.
• The site will be hosted on a Windows NT web server at an existing domain name

(www.pghvis.org) using our current hosting provider, Stargate.net, inc.
(http://www.stargate.net/).

• Delivered pages must be maintainable using Microsoft FrontPage.
• All pages must meet “Bobby Approved” web accessibility guidelines

(http://www.cast.org/bobby/).
• The target date for launching the redesigned site is 1 November 2001.

Please provide a price and timeframe estimate for web site production according to the
specifications above, including details on any discounts you may have for non-profit
organizations.  If you have any questions, please contact Mickey King, Coordinator of
Public Education at 412-682-5600 ext. 2287.


